
 

0 
 

   

WORKSHEETS 



 

1 
 

Q1: Tick the correct answers. 

1. ………………….………. is a computer used for weather forecasting. 

a) Laptop   b) Tablet   c) Supercomputer 

 

2. ………………….………. is a small, lightweight and portable computer. 

a) Desktop   b) Laptop   c) Supercomputer 

 

3. Computers are used in hospitals for   ………………….………. 

a) diagnose diseases  b) drawing   c) making timetable 

 

4. The data we enter into the computer is called ………………….………. 

a) Output   b) Input   c) instructions 

 

5. ………………….………. is an input device that is used to record the voice. 

a) Mouse   b) Speaker   c) Microphone 

 

6. The device used to view the result is called ………………….………. 

a) Input device  b) Output device  c) Processor 

 

Q2: Fill in the blanks. 

1. ………………….………. is a device used to give output in the form of sound. 

2. A ………………….……… is the main storage device in a computer. 

3. A ………………….………. is used to display the output on a screen. 

4. You can watch ………………….………. and listen ………………….………. on the computer. 

5. Computers are used in office for sending and receiving ………………….………. . 

6. Computer works very ………………….………. without making any ………………….………. . 

Q3: State ‘T’ for true or ‘F’ for false statements. 

1. Computers can do only one task at a time.  

2. Supercomputers are big and powerful computers. 

3. In school, computers are used for preparing results. 

4. A keyboard is an output device. 

5. A scanner is used to scan the images. 

6. A printer gives results on paper. 
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Q4: Match the following. 

 

1. Monitor   

 

 

 

 

2. Scanner   

 

 

 

 

3. Microphone    

 

 

 

   

4. DVD   

 

 

 

 

5. Laptop   

 

 

 

 

6. Tablet   

 

Q5: Name the following. 

1. The computer used for weather forecasting.   ………………….………………… 

2. A special type of small size computer equipped with  
a digital camera, microphone and touch screen.   ………………….………………… 
 

3. An input device used to type words and numbers.   ………………….………………… 

4. The output we get on paper.        ………………….………………… 

5. A circular-shaped storage device.     ………………….………………… 

a)  

b)  

c)  

d)  

e)  

f)  
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Q6: Application-based question. 

Renu wants to store her work on the computer and show it to her teacher. Which Storage 

device can she use to carry her data? 

………………………………………………………………………………………………………………………………………………. 
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Q1: Tick the correct answers. 

1. The ……………….……………….… tool is used to make freehand drawings. 

a) Line tool   b) Fill tool   c) Paint tool 

 

2. The ……………….……………….… tool is used to paste photographic images. 

a) Magic tool   b) Stamp tool   c) Fill tool 

 

3. A ……………….……………….… is a word processing program. 

a) Paint   b) Word   c) Tux Paint 

 

4. The ……………….……………….… bar is located at the top of the window. 

a) Ribbon   b) Title    c) Menu 

 

5. To start a new paragraph, we must press the……………….……………….… key. 

a) Spacebar   b) Shift                 c) Enter 

 

6. The ……………….… option is used to make a text underline. 

a)     b)     c)  

 

Q2: Fill in the blanks.  

1. ………………….………………..…. is the process of saving your work permanently. 

2. MS Word is used to create all kinds of ………………….……………….…. . 

3. Keyboard shortcut used to underline the selected text is ………………….……………….…. . 

4. You can enter text with the help of ………………….……………….…. . 

5. ………………….……………….…. displays groups of related commands in the tab. 

6. ………………….……………….…. are played when tools are selected. 

Q3: State ‘T’ for true or ‘F’ for false statements. 

1.  Paint tool is used to make straight lines in Tux Paint. 

2.  Fill color is used to fill color in any closed shape. 

3.  Slide Show is used to run scenes of a story in a sequence. 

4.  Magic tool is used to give special effects to the drawing. 

5. Word is a program used to create presentations. 
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6. Cursor is a small vertical flashing line on the screen. 

7. The shortcut key to underline the text is Alt + U. 

Q4: Answer the following questions. 

1. What is the purpose of Tux Paint? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

2. How does a slide show helpful for presentation? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

3. What is the use of Title Bar? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

4. How will you come to know that your text is selected? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

5. What do the File tab displays? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

6. What do you mean by storage? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

Q5: Who am I? 

1. To make freehand drawings.      ……………………….…….………. 

2. To start a new drawing.      ……………………….…….………. 

3. To save your drawing      ……………………….…….………. 

4. To run the scenes in the proper sequence.    ……………………….…….………. 
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5. Display groups of related commands in Tab.   ……………………….…….………. 

6. By pressing me, you can start a new paragraph.   ……………………….…….………. 

7. Make your text appear dark.      ……………………….…….………. 

8. To create all kinds of documents.     ……………………….…….………. 

Q6: Application-based question. 

Riddhi wants to type a paragraph on “Festivals of India”. She wants to make it eye-catching 

and colorful. But she doesn't know how to do it. Guide her how can she do that? 

……………………………………………………………………………………………………………………………………………….

……………………………………………………………………………………………………………………………………………….

………………………………………………………………………………………………………………………………………………. 
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Q1: Tick the correct answers. 

1. You can withdraw money from ……………….……………….… 

a) Emails   b) Desktop   c) ATM 

 

2. Computer can be used for reservation of tickets at ……………….……………….… 

a) Railway Station  b) Airports   c) Both 

 

3. The output we got as a printout is called ……………….……………….… 

a) Hard copy   b) Soft copy   c) None 

 

4. A ……………….……………….… is a portable storage device also known as a flash drive. 

a) Hard disk   b) Pen drive   c) DVD 

 

5. The sound effect can be disabled by pressing the ……………….……………….… key. 

a) Alt + S   b) Shift + S    c) Ctrl + S 

 

6. The ……………….……………….…  tool is used to exit from tux paint. 

a) Esc    b) Eraser   c) Quit 

 

7. The shortcut key used to save the document is ……………….……………….… . 

a) Ctrl + S   b) Alt + S   c) Shift + S 

 

8. A ……………….……………….… is a small blinking line on the screen. 

a) Cursor   b) Pointer   c) blinker 

 

Q2: Fill in the blanks. 

1. A mouse is also called an ……………….…………….………. device. 

2. An ……………….…………….………. device is used to enter data into the computer. 

3. Computers can maintain accounts of customers in ……………….…………….………. . 

4. ……………….…………….………. computers are small and are placed on desks. 

5. Selected text appears ……………….…………….………. on your screen. 

6. Fill tool is available in ……………….…………….………. tool. 

7. Tux Paint was developed by ……………….…………….………. . 
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Q3: State ‘T’ for true or ‘F’ for false statements. 

1. Tux Paint is a free drawing program only for Windows.  

2. You cannot resize or flip the Stamps. 

3. You can enter the text with the help of the mouse. 

4. To select a word, you have to double-click on the mouse button. 

5. A tablet is smaller than a Smartphone. 

6. You cannot play games on the computer. 

7. A CD is used to enter the data into the computer. 

8. Storage devices are used to store our work for the future. 

Q4: Answer the following questions. 

1. What is the use of a Stamp tool?  

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

2. Which tool is used to enter text and numbers in Tux Paint? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

3. How can you increase or decrease the size of your text? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

4. When did MS Word release first? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

5. Write the full form of the CD and DVD. 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

6. Write any two uses of the computer in school. 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 
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7. What is the purpose of input devices? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

Q5: Name the following. 

1. Any two input devices.    ……….………………….…………………... 

2. Any two Output devices.    ……….………………….…………………... 

3. Any two storage devices.    ……….………………….…………………... 

4. The computer used for research purposes.  ……….………………….…………………... 

5. The tool used to add effects to the drawing.  ……….………………….…………………... 

6. The toolbar that displays quick access buttons. ……….………………….…………………... 

Q6: Application-based question. 

Ashu created a storyline in Tux Paint. He wants to show his story in sequence. Which option 

can he use to do so? 

………………………………………………………………………………………………………………………………………………. 
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Q1: Tick the correct answers. 

1. All the image editing tools are present in ……………….……………….… . 
a) Home Tab    b) View Tab    c) Zoom tab 

 

2. ……………….……………….… tab is used to see the image in full-screen mode. 

a) View Tab   b) Home Tab    c) None 

 

3. It creates a mirror image of the picture. 

a) Rotate   b) Resize   c) Flip 

 

4. ……………….……………….… is the shortcut key to cut the image. 

a) Ctrl + X   b) Ctrl + V   c) Alt + E 

 

5. ……………….……………….… are regular arrangements of lines, shapes and colors. 

a) Designs   b) Patterns   c) Decomposition 

 

6. ……………….……………….… means breaking down a problem into smaller parts are 

easier to understand. 

a) decomposition  b) pattern   c) coding 

 

Q2: Fill in the blanks. 

1. ……………………………..………. command is used to change the position of the image. 

2. Save option is available in the ……………………………..………. tab. 

3. ……………………………..………. tool picks a color from a coloured drawing. 

4. The representation of information using symbols is called ……………………………..………. . 

5. ……………………………..………. is the shortcut key to paste the image. 

Q3: State ‘T’ for true or ‘F’ for false statements. 

1. You cannot edit drawing in Paint.  

2. The save option is present in File Menu. 

3. Color Palette contains three boxes. 

4. Zoom In and Zoom Out options are present in View tab. 

5. Skew option creates a mirror image of the picture. 

6. Crop feature is used to change the size of the image. 
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Q4: Define the following. 

1. Coding …………………………………..………………………………………………………………………………….. 

…………………………………………………………………………………………………………………………………… 

2. Decomposition ……………………..…………………………………………………………………………………… 

………………………………………………………………………………………………………………………………….. 

3. Repeating Pattern ………………..…………………………………………………………………………………… 

………………………………………………………………………………………………………………………………….. 

4. Skew ….…………………………………..…………………………………………………………………………………. 

………………………………………………………………………………………………………………………………….. 

5. Flip ………………………………………..………………………………………………………………………………….. 

………………………………………………………………………………………………………………………………….. 

Q5: Name the following. 

1. Two Tabs present in Paint.     ………………..………….………. 

2. Buttons present in Quick Access Toolbar.   ………………..………….………. 

3. Any two-editing feature in Paint.    ………………..………….………. 

4. The feature that creates a mirror image.   ………………..………….………. 

5. When the sequence repeats by adding something.  ………………..………….………. 

Q6: Application-based question. 

Ankit has created a drawing in paint. He wants to resize his drawing, but he doesn't know how 

to do it. Explain to him the step-by-step procedure to resize it. 

………………………………………………………………………………………………………………………………………………. 
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Q1: Tick the correct answers. 

1. It empowers you to create technology. 

a) Playing   b) Downloading  c) Coding 

2.  It lets you run Android games and apps on a desktop computer. 

 a) Scratch    b) BlueStacks   c) Paint 

3. A place where you make your programs in Scratch Jr. 

 a) Pages   b) Script Area   c) Stage  

4. The ability to deal with changing situations is called ……………….……………….… . 

a) Intelligence   b) Thinking   c) Working 

5. ……………….……………….… is an AI personal assistant. 

a) Siri    b) Alexa   c) both  

6. A normal machine is fed with ………………….………. . 

a) emotions   b) instructions   c) sound 

Q2: Fill in the blanks. 

1. Digital assistants use ……………………………….………. to perform various tasks. 

2. ……………………………….………. is the movie based on an AI robot programmed with 

human intelligence and emotions. 

3. To move the sprite ……………………………….………. blocks are used. 

4. ……………………………….………. is the place where the sprite moves. 

5. To start your main program, click on a ……………………………….………. . 

6. You can download the ……………………………….………. version of Scratch Jr. on the desktop 
computer. 

 

 Q3: State ‘T’ for true or ‘F’ for false statements. 

1. In AI, robots are developed to think like humans.  

2. AI-programmed machines work based on only given instructions. 

3. A smart music system with AI plays music through CD or a DVD.  

4. You can run ScratchJr. only on Tablet. 

5. The blocks are stacked together in the script area. 

6. You cannot change the background of the stage. 

Ch – 7 and 8 WORKSHEET – 5  
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Q4: Define the following. 

1. Sprite ………………………………………………………………………………………………………………………… 

……………………………………………………………………………………………………………………….…………. 

2. Script …………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………….………….. 

3. Coding ……………………………………………………………………………………………………………………….. 

……………………………………………………………………………………………………………………….………….. 

4. Artificial Intelligence ………………………………………………………………………………………………….. 

……………………………………………………………………………………………………………………….………….. 

Q5: Answer the following questions. 

1. How many categories of color-coded blocks are there in ScratchJr.? Name them 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

2. How can you use Scratch Jr. on a desktop? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

3. What is Coding?  

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

4. What is Artificial Intelligence? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

5. How can you differentiate between a Normal machine and an AI-enabled machine? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 
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6. Name some games based on AI technology. 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

Q6: Application-based question. 

Aisha wants to download ScratchJr on her desktop. How can she do it? 

……………………………………………………………………………………………………………………………………………….

………………………………………………………………………………………………………………………………………………. 
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Q1: Tick the correct answers. 

1. ……………….……………….… option is used to stretch an image only from one end. 

a) Resize   b) Skew   c) Flip 

2. Convert the information back to its original form, called ……………….……………….… . 

a) coding   b) decoding   c) designing 

3. It is a character that performs all actions in ScratchJr. 

a) Stage   b) Sprite   c) Flag 

4. In Rock, Paper, Scissors, Paper beats ………………….………. by covering it. 

a) Scissors   b) Rock   c) Paper 

5. AI games maintain the ………………….………. of the players. 

a) emotions   b) interest   c) goal 

6. ……………….……………….… means breaking down a problem into smaller parts that are 

easier to understand. 

a) Coding   b) Pattern   c) Decomposition 

7. Save as option is available in ……………….……………….… 

a) Home Tab   b) File Tab   c) View Tab 

 

Q2. Fill in the blanks. 

1. ………………………….………. is a drawing program used to draw and color objects. 

2. The repetition of the sequence is called ………………………….………. pattern. 

3. By default, the background of the stage is ………………………….………. . 

4. The goal of AI is to make computers take intelligent ………………………….………. . 

5. Dotted ………………………….………. shows that the object has been selected. 

6. ………………………….………. command is used to see only the selected part of the drawing. 

7. Converting the information back to its original form is called …………………………….……. . 

8. To make a new project, click on …………………………….………. sign. 
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Q3. State ‘T’ for true or ‘F’ for false statements. 

1. Cat is the main character in ScratchJr.  

2. Siri understands the voice commands and completes the task for the user. 

3. Ctrl + C is the shortcut key to copy the image. 

4. Quick Access Toolbar is present at the top right corner of the window. 

5. By default, ScratchJr. is installed on your device. 

6. Terminator is a movie based on an AI robot programmed. 

7. Addition to a pattern every time is called a growing pattern. 

8. You cannot save a file in Paint. 

Q4: Difference between the following. 

1. Skew      Flip 

…………………………………………………………….. …………………………………………………………….. 

…………………………………………………………….. …………………………………………………………….. 

…………………………………………………………….. …………………………………………………………….. 

2. Coding       Decoding 

…………………………………………………………….. …………………………………………………………….. 

…………………………………………………………….. …………………………………………………………….. 

…………………………………………………………….. …………………………………………………………….. 

 

3. Normal Machine     AI-based machine 

…………………………………………………………….. …………………………………………………………….. 

…………………………………………………………….. …………………………………………………………….. 

…………………………………………………………….. …………………………………………………………….. 

4. Growing Pattern     Repeating Pattern 

…………………………………………………………….. …………………………………………………………….. 

…………………………………………………………….. …………………………………………………………….. 

…………………………………………………………….. …………………………………………………………….. 

 

0 

0 
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Q5: Answer the following. 

1. What are the different formats you can use to save your file in Paint? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

2. What are coding and decoding? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

3. What do you understand by Decomposition? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

4. What is Script in ScratchJr.? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

5. What is the goal of AI? 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

6. Give some examples of the devices based on AI we see around us. 

……………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………… 

 

 


